Creep Response of a Prestressed Concrete Beam under Sustained Load
Outline

1 Description

2 Finite Element Model
   2.1 Units
   2.2 Geometry Definition
   2.3 Boundary Constraints
   2.4 Properties
      2.4.1 Concrete Beam
      2.4.2 Steel Plates
      2.4.3 Passive Longitudinal Reinforcement
      2.4.4 Stirrups
      2.4.5 Prestressing Tendons
      2.4.6 Interfaces
   2.5 Loads
      2.5.1 Self-Weight
      2.5.2 Post-Tensioning Load
      2.5.3 Point Load
      2.5.4 Load Combinations and Time Dependent Factors
   2.6 Meshing

3 Structural Nonlinear Analysis
   3.1 Analysis Commands
   3.2 Results
      3.2.1 Displacements
      3.2.2 Stresses and Crack Indexes

Appendix A Additional Information
1 Description

This tutorial presents the simulation of a creep benchmark: a partially prestressed flexural beam tested under sustained load by Espion and Halleux in 1991\(^1\).

A series of partially prestressed concrete beams were tested in the University of Brussels between 1981 and 1986 by Espion and Halleux. The experimental tests were composed by simple supported beams with 8.0 m of span and rectangular cross-sections of 0.34 m width and 0.4 m high, tested under sustained load during 4.5 years. These tests are a recognized benchmark used to validate finite element models for the time-dependent behaviour of concrete beams\(^2\).

This tutorial relates to beam LT05Q. The geometric characteristics and reinforcement layout of the beam is presented in Figure 1. The prestress tendons have a linear variation with an inclination of 3.2° with the horizontal axis between the load points and the supports. Transversal reinforcement consists of 10 mm stirrups distanced of 0.125 m in the shear span and 0.25 m in the central zone.

Figure 1: Characteristics of the creep beam test LT05Q from Espion & Halleux 1991

---

\(^1\)Espion and Halleux, *Long term behavior of prestressed and partially prestressed concrete beams: experimental and numerical results*, 1991

\(^2\)Espion, *Benchmark examples for creep and shrinkage analysis computer programs. Creep and shrinkage of concrete*, 1993
The beam was cured for a period of 1 day. After that it was maintained at a constant relative humidity of 60% and constant temperature of 20 °C.

The mechanical properties of the materials are indicated in Table 1. To model concrete we will use a class type of Model Code 2010 (MC2010) that better fits these properties (C25).

A prestress force of 1228 kN per tendon was applied by post-tension in one of the extremities at the age of 14 days. Two concentrated loads $Q$ were applied at different time stages ($Q = 16.5$ kN at 28 days and increased to $Q = 63.75$ kN at 84 days of age). The load history is presented in Table 2. Cracks were observed in the beam after application of the second load phase ($Q = 63.75$ kN) as reported in Espion 1993.

### Table 1: Material properties

<table>
<thead>
<tr>
<th>Material</th>
<th>Young's modulus $E$ (N/m$^2$)</th>
<th>Compressive strength $f_{cm}$ (N/m$^2$)</th>
<th>Tensile strength $f_{tm}$ (N/m$^2$)</th>
<th>Mass density $\rho$ (kg/m$^3$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete</td>
<td>30.75E9</td>
<td>33.9E6</td>
<td>3.0E6</td>
<td>2350</td>
</tr>
<tr>
<td>Reinforcement steel</td>
<td>200E9</td>
<td>8000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prestress steel</td>
<td>200E9</td>
<td>8000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Steel for plates</td>
<td>210000</td>
<td>0.3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 2: Loading history

<table>
<thead>
<tr>
<th>Time (days)</th>
<th>Self weight (kN/m)</th>
<th>Post-tension (kN/cable)</th>
<th>Load $Q$(kN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 &lt; $t$ &lt; 14</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>14 ≤ $t$ &lt; 28</td>
<td>3.3</td>
<td>122.8</td>
<td>0</td>
</tr>
<tr>
<td>28 ≤ $t$ &lt; 84</td>
<td>3.3</td>
<td>122.8</td>
<td>16.5</td>
</tr>
<tr>
<td>84 ≤ $t$ &lt; 1642</td>
<td>3.3</td>
<td>122.8</td>
<td>63.75</td>
</tr>
</tbody>
</table>

Espion, Benchmark examples for creep and shrinkage analysis computer programs. Creep and shrinkage of concrete., 1993
To model this benchmark we use a 3D finite element model with solid elements for the beam and embedded truss elements for longitudinal and transversal reinforcements [Fig. 2]. The following considerations were taken into account:

1. Due to symmetry, only half of the beam is modeled. We opt not to model one quarter because of the configuration of the reinforcement and prestressing.

2. The concrete behavior is modeled through the MC2010 expressions available in DIANA (Concrete class C25), including creep and shrinkage effects. For the sake of simplicity, total strain crack models were not included.

3. The reinforcement steel (passive and active) is modeled with embedded reinforcements with linear elastic behaviour. We used non-bonded embedded reinforcements for the application of post-tension in the prestressing cables.

4. The steel plates for load application and support (0.15 m of length and 0.035 m thick) are modeled with linear elastic material properties.

5. Interface elements are used between the steel plates and the concrete beam, with high normal stiffness and low shear stiffness modulus.

6. A structural nonlinear analysis is performed with time steps until a total time of approximately 4.5 years. The experimental and numerical results are compared in terms of displacements versus time.

Figure 2: 3D FE model of the creep beam test LT05Q
2 Finite Element Model

For the modeling session we start a new project. We will dominantly use quadratic hexagonal elements.

Main menu ➔ File ➔ New  [Fig. 3]

Figure 3: New project dialog
2.1 Units

We use SI units (N, m, s) with the exception of temperature that we change to Celsius. Despite the fact that it would be handy to have the time unit in days we keep it in seconds (SI) to have a consistent unit set [Fig. 5].

Figure 4: Model window

Figure 5: Property Panel - Units
2.2 Geometry Definition

We start the model by making 3 blocks: one for the beam, one for the support plate and one for the loading plate.
Main menu ➔ Geometry ➔ Create ➔ Add block ➔ Figure 8 [Fig. 9] ➔ Figure 8: Geometry - Add block

Figure 8: Geometry - Add block

Figure 9: Geometry - Support plate

Support plate
Position:
Size:
0.0 - 0.035 m
0.075 0.34 0.035 m
Main menu ➔ Geometry ➔ Create ➔ Add block ➔ [Fig. 10] [Fig. 11]

Figure 10: Geometry - Add block

Figure 11: Geometry - Loading plate
We now add a point in the middle of the loading plate to later attach the load.

**Main menu** ➔ Geometry ➔ Create ➔ Add point ➔ [Fig. 12] [Fig. 13]
We need to imprint this point to be part of the loading plate.

**Main menu** ➔ Geometry ➔ Modify ➔ Shape projection

![Diagram](https://dianafea.com)

Figure 14: Geometry - Imprint

Figure 15: Geometry - Loading point
We will now define the reinforcement.

We start by creating 13 lines for the ordinary longitudinal reinforcement (see Figure 1). We have 4 layers of passive reinforcement in the cross-section: R1-1 means layer 1 reinforcement 1, R2-1 means layer 2 reinforcement 1, etc. The coordinates of the lines are listed in Table 3.

![Figure 16: Add line - Longitudinal reinforcement](https://dianafea.com/13/54/)

**Table 3: Coordinates for defining the lines for passive reinforcement**

<table>
<thead>
<tr>
<th>Name</th>
<th>Point 1</th>
<th>Point 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1-1</td>
<td>0.035, 0.373</td>
<td>4.035, 0.373</td>
</tr>
<tr>
<td>R1-2</td>
<td>0.125, 0.373</td>
<td>4.125, 0.373</td>
</tr>
<tr>
<td>R1-3</td>
<td>0.215, 0.373</td>
<td>4.215, 0.373</td>
</tr>
<tr>
<td>R1-4</td>
<td>0.305, 0.373</td>
<td>4.305, 0.373</td>
</tr>
<tr>
<td>R2-1</td>
<td>0.035, 0.285</td>
<td>4.035, 0.285</td>
</tr>
<tr>
<td>R2-2</td>
<td>0.125, 0.285</td>
<td>4.125, 0.285</td>
</tr>
<tr>
<td>R2-3</td>
<td>0.215, 0.285</td>
<td>4.215, 0.285</td>
</tr>
<tr>
<td>R2-4</td>
<td>0.305, 0.285</td>
<td>4.305, 0.285</td>
</tr>
<tr>
<td>R3-1</td>
<td>0.035, 0.115</td>
<td>4.035, 0.115</td>
</tr>
<tr>
<td>R3-2</td>
<td>0.125, 0.115</td>
<td>4.125, 0.115</td>
</tr>
<tr>
<td>R3-3</td>
<td>0.215, 0.115</td>
<td>4.215, 0.115</td>
</tr>
<tr>
<td>R3-4</td>
<td>0.305, 0.115</td>
<td>4.305, 0.115</td>
</tr>
<tr>
<td>R4-1</td>
<td>0.035, 0.035</td>
<td>4.035, 0.035</td>
</tr>
<tr>
<td>R4-2</td>
<td>0.125, 0.035</td>
<td>4.125, 0.035</td>
</tr>
<tr>
<td>R4-3</td>
<td>0.215, 0.035</td>
<td>4.215, 0.035</td>
</tr>
<tr>
<td>R4-4</td>
<td>0.305, 0.035</td>
<td>4.305, 0.035</td>
</tr>
<tr>
<td>R4-5</td>
<td>0.035, 0.035</td>
<td>4.035, 0.035</td>
</tr>
</tbody>
</table>

Tip: here we can also make use of the array copy tool, for example: create R1-1 and array copy it 3 times for 0.090 m in Y direction; create R4-1 and array copy it for 0.0675 in the Y direction.
Figure 17: View of the model - Longitudinal reinforcement
We now define the polygon lines for the 5 prestress tendons (see Figure 1). There are 3 layers of prestressing reinforcement: line P1-1 means layer 1 prestress tendon 1, P2-1 means layer 2 prestress tendon 1, etc. The coordinates of the polygon lines are listed in Table 4.

![Figure 18: Add polyline - Prestress tendon](image.png)

<table>
<thead>
<tr>
<th>Name</th>
<th>Point 1</th>
<th>Point 2</th>
<th>Point 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1-1</td>
<td>0, 0.07, 0.2518</td>
<td>2, 0.07, 0.140</td>
<td>4, 0.07, 0.140</td>
</tr>
<tr>
<td>P1-2</td>
<td>0, 0.27, 0.2518</td>
<td>2, 0.27, 0.140</td>
<td>4, 0.27, 0.140</td>
</tr>
<tr>
<td>P2-1</td>
<td>0, 0.17, 0.2268</td>
<td>2, 0.17, 0.115</td>
<td>4, 0.17, 0.115</td>
</tr>
<tr>
<td>P3-1</td>
<td>0, 0.07, 0.2018</td>
<td>2, 0.07, 0.090</td>
<td>4, 0.07, 0.090</td>
</tr>
<tr>
<td>P3-2</td>
<td>0, 0.27, 0.2018</td>
<td>2, 0.27, 0.090</td>
<td>4, 0.27, 0.090</td>
</tr>
</tbody>
</table>

Table 4: Coordinates for defining the polylines for prestress tendons

Tip: here we can also use array copy tool from P1-1 to P1-2 and from P3-1 to P3-2.
Figure 19: View of the model - Active and passive longitudinal reinforcement
We now define the transversal reinforcement. For that we need to create closed polygon lines with the dimensions of the stirrups distanced by 0.125 m in the shear span and by 0.25 m in the central zone.

We define the first double leg stirrup from the bottom to the top reinforcements and at a distance of 0.035 m from the edge of the beam. We array copy that line 15 times with a distance of 0.125 m [Fig. 21].

---

**Main menu** ➔ Geometry ➔ Create ➔ Add polyline

**Main menu** ➔ Geometry ➔ Modify ➔ Array copy

---

Figure 20: Geometry - Add polyline stirrup

Figure 21: Geometry - Array copy stirrups
We copy the last stirrup (Stirrup 16) once with a distance of 0.09 m to be aligned with the load point [Fig. 22]. Finally we copy this last one (Stirrup 17) 8 times at a distance of 0.25 m [Fig. 23].
The definition of the reinforcement is complete.

Figure 24: View of the model - reinforcement
We can organize the geometry of the model into folders and shape sets. For that we add three new shape sets: ‘Beam’, ‘Passive reinforcements’, ‘Prestressed reinforcements’ and ‘Stirrups’. We select the shapes and create the new sets from the selection. In this way we can easily select the different parts of the model, which can be especially advantageous in the results checking phase.

**Geometry browser** → **Geometry** → `<select shapes>` → ![New shapeset from selection](https://dianafea.com) [Fig. 25]

![Figure 25: Add shape sets](https://dianafea.com)
2.3 Boundary Constraints

We restrict the translation in the Z direction along the bottom edge of the support plate.

Figure 26: Add line support
Figure 27: View of the model - Line support
We restrict the translation in the Y direction in one vertex of the bottom edge of the support plate. We change the view of the model to **Left view** to see the point support.

**Main menu** → **Geometry** → **Assign** → **Supports**  
**Main menu** → **Viewer** → **Viewpoints** → **Left view**

---

*Figure 28: Add point support*  
*Figure 29: View of the model - Point support*
Due to the symmetry condition we restrict the translation in the X direction in the symmetry surface. We change the view of the model back to **isometric view 1**.

---

**Main menu** → **Geometry** → **Assign** → **Supports**  
[Fig. 30]

**Main menu** → **Viewer** → **Viewpoints** → **Isometric view 1**

---

![Figure 30: Add surface support](image1.png)

![Figure 31: View of the model - Symmetry support](image2.png)
2.4 Properties

2.4.1 Concrete Beam

To model the concrete we use the concrete design codes class available in DIANA. We chose the MC2010 (Class C25). We include creep and shrinkage effects. Ambient temperature is 20 °C, notional size of member \( (h = 2A_c/u) \) is 0.1837 and the relative humidity is 60%. We choose a non-aging creep curve type: concrete age at loading is 14 days (1209600s) and the concrete age at end of curing period is 1 day (86400s).

We use structural solid elements and we don’t need to define geometry and data.
2.4.2 Steel Plates

We assign the properties to the loading and support plates. Steel is considered as linear elastic Table 1. We use structural solid elements and we don’t need to define geometry and data.

Properties: Add material, Edit material

Figure 35: Assign plates properties

Figure 36: Add new material - Steel

Figure 37: Steel material properties
2.4.3 Passive Longitudinal Reinforcement

We now define the properties of the ordinary reinforcement. We define a new linear elastic material for the reinforcement steel [Table 1]. We need two geometry types for the \( \phi 8 \) bars (area \( 5 \times 10^{-5} \text{ m}^2 \)) and the bars \( \phi 18 \) bars (area \( 2.54 \times 10^{-4} \text{ m}^2 \)). We start with the \( \phi 8 \) bars (see Figure 1).

---

**Main menu** → Geometry → Assign → Reinforcement properties

Reinforcement properties → Material → Add material → Edit material

---

**Figure 38**: Assign reinforcement properties - \( \phi 8 \) bars

**Figure 39**: Add new material - Reinforcement steel

**Figure 40**: Material properties - Reinforcement steel
Figure 41: Edit new geometry - φ8 bars
We now define the $\phi_{18}$ bars (see Figure 1). We use the same material and we need to define a new geometry type.

Figure 42: Assign reinforcement properties - $\phi_{18}$ bars

Figure 43: Edit new geometry - $\phi_{18}$ bars
2.4.4 Stirrups

We now define the properties of the transversal reinforcement. We use the same material as in the longitudinal reinforcement and we define a new geometry for $\phi10$ ($7.85 \times 10^{-5} \text{ m}^2$).

![Assign reinforcement properties - $\phi10$ stirrups](image1)

![Edit new geometry - $\phi10$ stirrups](image2)
2.4.5 Prestressing Tendons

We now define the properties of the active reinforcement. We need a new linear elastic material for the prestressing tendons [Table 1]. We include the bonding aspect and set that the reinforcement is not bonded to mother element in order to have a post-tension load.

---

**Main menu** ➔ Geometry ➔ Assign ➔ Reinforcement properties [Fig. 46]

Reinforcement properties ➔ Material ➔ Add material [Fig. 47] ➔ Edit material [Fig. 48]

---

Figure 46: Assign reinforcement properties - Prestress tendons

Figure 47: Add new material - Prestress tendons

Figure 48: Material properties - Prestress tendons
We define a new geometry for the 0.5" cables (area 9.3e-5 m²).

Figure 49: Edit new geometry - Prestress tendons
2.4.6 Interfaces

We include structural surface interfaces between the steel plates and the beam. We define a no-tension interface with shear reduction. We use a high value for the normal stiffness and low values for shear stiffness.

Main menu ➔ Geometry ➔ Assign ➔ Connection properties

Connection properties ➔ Material ➔ Add material ➔ Edit material

---

Figure 50: Assign interface properties

Figure 51: Interface - Add new material

Figure 52: Interface - Material properties
2.5 Loads

2.5.1 Self-Weight

We first set the self-weight of the model.

Figure 53: Load - self-weight
2.5.2 Post-Tensioning Load

We define the post-tensioning load applied to one end of the prestress tendons. The anchor points are located in the extreme of the beam. The prestress force is 122.8 kN per tendon. This force was measured after application of prestress, so we don’t consider prestress losses.

Figure 54: Post-tension load

Figure 55: Model view - Postension load
2.5.3 Point Load

We define the point load in the middle of the loading plate with the value of 1 kN. We will afterwards define the true value of the applied load \((Q = 16.5 \text{ kN} \text{ and } Q = 63.75 \text{ kN})\) through load factors dependent on time.
2.5.4 Load Combinations and Time Dependent Factors

We create two geometry load combinations and define time dependent functions for each of it (see Table 2):

- Combination 1: self-weight and post-tension loads are applied at 14 days (1209600 s) and maintained in time
- Combination 2: point load is applied at 28 days (2419200 s) with the value of 16.5 kN and increased to 63.75 kN at 84 days (7257600 s).

We will make an analysis until 1642 days (141868800 s) so we define the table until 1750 days (151200000 s).
Figure 59: Time dependency for Combination 1

Figure 60: Time dependency for Combination 2

Note: once we create geometry load combinations we can no longer use the load cases for the analysis, we can only use combinations. When you create combinations, by default DIANAIE will present as many load combination as loads defined previously. In this case we have defined 3 loads and we only want 2 combinations so we have delete one of them.

Tip: make sure the time tables are defined for a period that is always equal or longer then the time considered in the analysis.
2.6 Meshing

We set the element size as 0.1 m and generate the mesh.

Main menu ➔ Geometry ➔ Assign ➔ Mesh properties  [Fig. 61]

Figure 61: Mesh properties

Figure 62: Model view - Mesh
3 Structural Nonlinear Analysis

3.1 Analysis Commands

We perform a structural nonlinear analysis with time steps. As the load execute block is the default, we first need to remove it, and then add a new execute block with time steps.

---

**Main menu → Analysis → Add analysis** [Fig. 63]

**Analysis browser → Analysis1 → Add command → Structural nonlinear** [Fig. 64]

**Analysis browser → Analysis1 → Structural nonlinear → new execute block → Remove**

**Analysis browser → Analysis1 → Structural nonlinear → Add... → Execute steps - Time steps** [Fig. 65]

**Analysis browser → Analysis1 → Structural nonlinear → new execute block → Rename → Time** [Fig. 65]
We choose user specified sizes for the time steps. We use small time steps in the beginning of the analysis (because is when creep deformations are more relevant) and also immediately after the application and increasing of the load. Afterwards, we use larger time steps until completing the 1642 days of the analysis.

The considered time steps are (in seconds):

1.0 1.2096e+06 43200.0(56) 86400.0(84) 172800.0(15) 432000.0(12) 5.184e+06(25) s

Note: The time steps in days are: 1.157E-5 14 0.5(56) 1(84) 2(15) 5(12) 60(25).
With the output user selection we choose the results of displacements, strains, stresses and crack index.

Finally we run the analysis.
3.2 Results

3.2.1 Displacements

We start the presentation of results with the curve of displacements at midspan versus time and comparison with experimental data.
We can see the graph of displacements versus time steps in DIANAIE.

![Graph of displacements versus time steps](https://dianafea.com)

Figure 72: Table of total displacements

In order to compare the numerical results with the experiment data we copy the displacements from DIANAIE to Excel. We convert the time from seconds to days and the displacement from meter to millimeters.
In general, we can observe a good agreement between the numerical and experimental results.

This fitting is specially good during the post-tensioning stage and after the application of the first load. The computed long-term response after the second increment of load at 84 days starts to deviate from the experimental results. The model presents a stiffer response than the experiment. This is due to the fact that, for the sake of simplicity of the model, we are not considering cracking in the simulation. And after the second application of load the beam is cracked, as we are going to see from the stress results. The cracking after the second load application was also observed experimentally, as reported in Espion and Halleux 1991.

Note: Considering cracking in the creep analysis would increase significantly the complexity and computation time of the analysis.

We are now presenting the contour plots of several results and we first hide the steel plate parts from the mesh [Fig. 74]. We start with the displacements in the Z direction for the different stages of the analysis:

i) post-tensioning and self-weight at 14 days, ii) application of the first load at 28 days, iii) increment of the load at 84 days, iv) final time at 1716 days.

In the instant immediately after the application of the post-tensioning we can observe the curvature of the beam [Fig. 76].
This deformed configuration changes after the application of the first load [Fig. 77]. We can observe the increment of displacements with time by comparing with the values of displacements immediately before the second application of the load [Fig. 78].

Figure 77: Total displacement in Z direction at $t = 28$ days

Figure 78: Total displacement in Z direction at $t = 83$ days
Figure 79 shows the displacements after the application of the second load and Figure 80 at final time of analysis.

We can see the significant increment of displacements in the beam under constant load due to the time-dependent effects, mainly creep effects.
3.2.2 Stresses and Crack Indexes

We now present the principal stresses. For principal stresses $S_1$ we make a contour plot and set the legend to a maximum of 3 MPa, to check if the beam is cracked. We also switch off the deformed shape view.

---

**Results browser** → **Analysis1** → **Output** → **Element results** → **Cauchy Total Stresses** → **S1**  
**Property Panel** → **Result** → **Color scale limits**

---

**Figure 81: Result tree - Cauchy Total Stresses**

**Figure 82: Contour plot settings**

---

Creep Response of a Prestressed Concrete Beam under Sustained Load | https://dianafea.com
We see the maximum principal stresses for the instant after the application of the second load at $t = 84$ days and for the final time of analysis at $t = 1716$ days. The beam presents high crack risk in some locations (in red).

Figure 83: Maximum principal stresses $S_1$ for $t = 84$ days

Figure 84: Maximum principal stresses $S_1$ for $t = 1716$ days
We can also check the Crack Index. For that we put the contour plot settings back to default: autoscale to display results.

**Results browser** → Analysis1 → Output → Element results → Crack Indices → Ftu  
**Property Panel** → Result → Color scale limits → Auto-scale to displayed results

---

*Figure 85: Result tree - Crack Indices*

*Figure 86: Default contour plot settings*
So we also see the crack index $F_{tu}$ for the instant after the application of the second load at $t = 84$ days and for the final time of analysis at $t = 1716$ days. The crack index $F_{tu}$ is determined as $F_{tu} = \frac{\sigma}{f_t}$. In the areas with $F_{tu} > 1$ there is risk of cracking. We can observe that after the second load application [Fig. 87] the beam is cracked, which is the reason for the difference between the numerical and experimental results appearing at this stage.
We will now look into the compressive stresses in the beam after the application of the second load at 84 days. It is generally accepted that creep in concrete is linear when stresses remain below $0.45f_{cm}$.

We can observe from the contour plot of minimum principal stresses $S_3$ that the beam is mostly in the linear stage ($\sigma < 0.45 \times 33.9 \text{ MPa} = 15.255 \text{ MPa}$), so the linear creep strain assumption is valid. We can also observe the relaxation of stresses in time by comparing Figure 89 (after application of the second load for $t = 84$ days) and Figure 90 (at the end of the analysis for $t = 1716$ days).
Appendix A  Additional Information

Folder: Tutorials/CreepPrestressBeam

Number of elements $\approx 700$

Keywords:
- ANALYS: nonlin physic.
- CLASS: large.
- CONSTR: suppor.
- ELEMEN: bar chx60 cq48i ctp45 interf reinfo solid struct.
- LOAD: anchor force node postte reinfo time weight.
- MATERI: concre creep elasti harden isotro maxwel mc2010 plasti shrink strain viscoe vonmis.
- OPTION: direct newton regula units.
- POST: binary ndiana.
- PRE: dianai.
- RESULT: cauchy crack crkind displa green princi status strain stress total.

References:


Disclaimer: The aim of this technical tutorial is to illustrate various tools, modelling techniques and analysis workflows in DIANA. DIANA FEA BV does not accept any responsibility regarding the presented cases, used parameters, and presented results.